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UNI VERSITY OF NEW SOUTH WALES
FACULTY OF THE BUILT ENVIRONMENT

TUTORIAL INTRODUCTIONS TO CAD

AUTOCAD 2000 - Drawing the Granny Flat Plan

Jim Plume

In this tutorial we are going to produce a simple plan drawing of a "granny flat"
(illustrated in Figure 1).  In this exercise you will follow through one method of
drafting using AutoCAD.  Although the tutorial is clearly directed towards
architectural drawing, some attempts will be made along the way to suggest how
these techniques can be applied to other disciplines.

It is important that you don't just follow the instructions in a "cookbook" style,
but that you observe the process, watching the AutoCAD prompts in the
Command Window.  You should gradually become sufficiently confident with
the basic commands of AutoCAD to start trying things out for yourself:  don't
be afraid to try to do things a different way to that described in these notes!!

Note that you can always use the Undo command to recover from errors made:
simply click the Undo tool button (illustrated) on the Standard toolbar or type u ↵↵↵↵
in response to the "Command:" prompt.  This command reverses the effect of
the last command executed.  You can use it as many times as you like to "undo"
back through your drawing session (at least as far back as the last time you
"saved" the drawing to file).  Note that the Redo command only reverses the
most recent undo operation.

BEDROOM

ENTRY PORCH

KITCHEN

BATH

LIVING /
DINING ROOM

Figure 1  -  The completed “Granny Flat” Drawing

C3

Using the Undo command ...

Undo – Redo command tools
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GETTING STARTED

To begin this tutorial, fire up AutoCAD (using Architectural Desktop) in the way
described in the first tutorial.  Select the Start from Scratch button using the
metric option.  Once AutoCAD is loaded, it is prudent to begin by telling it where
you want to store this drawing:  select File > Save As and, on drive S: (the
student storage folder) and in your own user’s folder, enter any name of your
own choice for the drawing file.

Note that, since we are about to begin a new drawing,  you will need to set the
Units and Limits for this new drawing.  For this exercise, make your drawing size
about 15,000 x 12,000.  Simply follow the same steps as you did during the last
two tutorials:  if you can, try to do it from memory by following the AutoCAD
prompts (you’ll find the commands in the Format menu).  Don't forget to use
Zoom All to view your whole drawing sheet before proceeding.

Before proceeding with this tutorial, we need to say a few things about the
Object Snap tools that were introduced in the last two tutorials.  Whenever you
are required to use object snap, I will indicate that by nominating which one
should be used, as in the following examples:  |ENDPoint|, to snap to the end
point or corner of an entity;  |MIDpoint|, to snap to the midpoint of an entity;  or
|PERpend|, to snap to a position so as to create an entity that is perpendicular to
the selected entity;  etc.

There are several ways to activate the object snap tools and I will leave it
entirely up to you which one you use in each context:

•  Generally, the simplest way is to use Running Objects Snaps, combined with
Polar Tracking and Object Tracking as described in Tutorial C2.  This allows
you to pre-select the ones you are likely to use, and then let AutoCAD
suggest them to you as you draw.

•  Picked from the Object Snap toolbar (as illustrated, which you can have
floating or docked all the time if you wish!).

•  Picked from the Object Snap flyout located around the middle of the
Standard toolbar (hold down the mouse button over the flyout button and
then move through the buttons slowly, reading the description of each on the
status line).

•  Typed in at the Command Window prompt (using the capitalised letters only).

•  Picked from the pop-up cursor menu (activated by holding down the <Shift>
key and clicking the right mouse button).

You should feel free to experiment with these now if you wish.  You will be
expected to know how to activate them in different circumstances as you
proceed.

DRAWING THE WALLS AND OPENINGS

A labelled plan of the granny flat is shown in Figure 1, serving as a guide for the
following description.  We will assume that north is up the page and refer to
things like "NE corner of the living room", etc).  We will start by drawing the
external walls using Multilines, beginning at the SW corner of the bedroom.

A multiline is simply a series of up to 16 parallel lines that are drawn as a single
entity.  Before using this entity, we have to define the style (number and spacing
of the parallel lines) that we wish to use.  AutoCAD’s standard multiline style (the
only one that is pre-defined) consists of two lines 1 drawing unit (in our case,
mm) apart!  We want the external wall to represent brick veneer construction,
with an inner skin consisting of a 100 timber stud wall, a cavity of 40 mm, and a
110 outer brick skin.  Further to that, we want to set out the multiline relative to

Assigning a file name to your
new drawing ...

Setting up this drawing ...

Don’t neglect to go through this
step!!

Precision Drafting ....

... the Object Snap tools.

Floating Object Snap Toolbar

How can we use multilines??



3 Updated:  April 2000 AUTOCAD 2000 - Drawing the Granny Flat Plan

the inside face of the inner skin, so that as we draw the line, we are actually
tracing the inside face of our little building.

Multilines are great for drawing walls in plan, but they are also useful for drawing
paths, roads and kerbing on site plans.  Their major limitation is that they cannot
be curved.

Format >
Multiline Style

Begin by issuing the Multiline Style command from the pull-
down menus ... AutoCAD will open the Multiline Styles
dialogue box ... then follow the steps set up below ...

•  highlight the existing entry in the text box labelled Name: (probably
“STANDARD”), and then type bv (standing for “brick veneer”) in its place;

•  then go to the text entry box labelled Description: and enter Brick Veneer
Wall;

•  click the Add button … this adds the new style to the list of available styles
and assigns it the properties of the current style (standard, in this case);

•  next, click the Element Properties button to open the Element Properties
dialogue box so that we can define the number and spacing of parallel lines
for this style;

•  in that dialogue box, highlight the first entry in the list and then double-click
the number (probably “0.5”) labelled Offset … type 250 in its place … then
highlight the second entry and replace its offset with 140;

•  next, click the Add button to insert another offset … its value will be set to 0.0
… simply replace that value with 100;

•  Now click the Add button again, leaving the offset value as 0 …we have now
defined 4 offset lines, the last positioned at 0.0 offset ... I hope you can see
how that defines a brick veneer wall in plan view!

•  click the OK button to return to the Multiline Styles dialogue box … do not be
tempted to click the Save button … that button is only used if you want to
save your multiline definitions in a file that can be loaded into another
drawing;

•  in the Multiline Styles dialogue box, make sure this new style is the one
named in the Current box and click OK to return to your drawing!

Although that process was tedious to explain, it is really very simple and quick.
You will have a chance to define your own multiline style in a few moments
when it is time to draw the internal walls!

To accurately draw the walls, we will type in the end point coordinates of each
multiline relative to its start point.  These are referred to as relative coordinates,
and can be entered as either an X/Y coordinate pair or a polar coordinate ... we
will use a mixture of both, explaining the syntax as we go along.

[Draw.Multiline] Issue the Multiline command …

s ↵↵↵↵ Select the scale option … in case the scale factor is set
wrongly …

1 ↵↵↵↵ Set the scale as 1 … then select a starting point near the
lower left corner of the drawing area (by moving the cross-
hairs to that point and then clicking the left mouse button),
then describe the internal dimensions of the flat thus …

@5500,0 ↵↵↵↵ “@” means a relative distance ... 5500 in the X direction
and 0.0 in the Y direction in this case ... results in a
horizontal line 5500 long.

@0,1200 ↵↵↵↵ Entry door.

Defining a Multiline Style ...

NOTE
Once you have used a multiline
style to draw some multilines, you
cannot go back and alter the
properties of that style.

Now to start drawing the walls ...

Multiline drawing tool.

Polar Tracking
Entering these lengths would be a
lot simpler using Polar Tracking as
explained in Tutorial C2 … you
should use that method if you can
recall how to do it!!
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@3500,0 ↵↵↵↵ Wall adjacent to entry porch.

@4800<90 ↵↵↵↵ This is a relative polar coordinate (used here purely so that
you can se how it works!) ... it means “4800 at 90o anti-
clockwise from 0o” ... that is, UP!

@9000<180 ↵↵↵↵ Another relative polar coordinate ... 9000 at 180o anti-
clockwise from 0o - ie LEFT.

c ↵↵↵↵ Closes the multiline by connecting it back to the starting
point ... you should now have a simple plan outline!

Click on the Zoom Window tool (Standard toolbar) and point to two positions just
outside opposite corners of your "granny flat" to define a rectangle (referred to
as a "window") around it - AutoCAD will redraw your drawing showing only the
part defined by the window.

Since this is a convenient "view" of the drawing (that we will probably want to
come back to time and time again), we are going to save it as a named view ...

View >
Named Views

Or click the button illustrated … calls up the View dialogue
(illustrated at the left) ... click the New button...

All Enter the name “All” in the View Name: slot of the New
View dialogue box … leave the Save UCS option selected
and then click the OK button … in the View dialogue, click
the Set Current button followed by OK.

Drawing the Internal Walls
We are going to use a similar method now to create the internal walls.  These
are single-skin timber walls 100 mm wide.  You need to begin by creating an
appropriate multiline style (let’s call it “ts”, for timber stud wall) using the
technique described earlier ... see if you can do that by yourself without having
to get help from a tutor!

Once you have created the new multiline style for the internal walls, proceed as
follows to create the internal wall that begins as the north wall of the bedroom (at
the back of the built-in wardrobe).

[Draw.Multiline] Invoke the multiline drawing tool ... AutoCAD prompts for a
starting point or to select one of the options ...

j ↵↵↵↵ Choose the Justification option ... AutoCAD normally draws
the multiline below or to the right of the cursor position as
we draw (as it did for the external walls) ... this time we
want the line that we enter treated as the “bottom” of the
multiline, that is, have the multiline constructed above and
to the left of the cursor position ... to do that, proceed as
follows ...

b ↵↵↵↵ Select the Bottom option ... now we are ready to enter the
starting point, but we need to use a snap mode ...

|FROM| Invoke the FROM object snap tool ... we do this because
we want to start this wall at an exact measured distance
(3700 mm) from the SW corner of the bedroom ...

|ENDPoint| Invoke the ENDPoint object snap mode because we need
to snap onto the SW corner of the bedroom ... use the
mouse to position the object snap box over the inside SW
corner of the bedroom.

Zooming in to get a larger view of
the drawing ...

Zoom Window tool.

Saving a displayed view by giving it
a name ...

The View Control dialogue box ...

Running Object Snaps …

You will find it useful in this section
to set a few running object snaps
…

From Object Snap Tool
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@3700<90 ↵↵↵↵ A relative polar coordinate, meaning 3700 mm at an angle
of 90o relative to 0o (taken as the “3 o’clock” direction and
measured anticlockwise) ... this fixes the starting point of
the multiline!

@1500<0 ↵↵↵↵ First segment of the multiline - north wall of wardrobe.

@700<270 ↵↵↵↵ 700 mm “down” - east side of wardrobe.

@2700<0 ↵↵↵↵ Remaining north wall of bedroom ... note that to enter the
last wall (east wall of bedroom) we use another object snap
mode ...

|PERpend| Use the PERpendicular object snap mode to select the
internal face of the south wall of the granny flat - AutoCAD
will snap to a point on that line such that the multiline
segment being drawn is perpendicular to it.

↵↵↵↵ To terminate the command.

That completes the main internal wall.  Don’t worry yet about cleaning up the
junction where this wall abuts the external wall ... we will come back to that very
shortly.

Using similar techniques, you should now draw the east wall of the bathroom,
beginning 2500 to the right of the inside top left corner of the plan.  Note that you
will again need to use the |FROM|, |ENDpoint| and |PERpend| object snap
modes in order to construct that multiline.

Breaking Openings in the Walls
We now have to break openings into the walls for the windows and doors.
There are (at least) two ways of doing that ... I’m going to show you both
because that provides an opportunity to explore a range of AutoCAD tools.

The main one we will use is the Multiline Edit command, using that initially to
create a 3000 opening in the south wall of the bedroom (see the completed
plan).  You will then use the same method on your own to create most of the
other openings ... the two openings in the north wall of the plan will be done later
using a different method that I will show you.

Begin by selecting Modify > Multiline from the pull-down menus.  AutoCAD will
open the Multiline Edit Tools dialogue box as illustrated in the left margin. Notice
some of the tools available (each depicted by an “image tile” which operates a
bit like a command button):  you can clean up intersections where multilines
cross or where they meet at a T-junction (first two columns);  you can clean up
corners and add/delete vertices (third column);  and you can break or repair
openings in multilines.  Click on the Cut All option (as indicated in the illustration)
and then click OK ... notice that AutoCAD prompts you to select the multiline that
you want to cut ... don’t point to it just yet, but rather proceed as follows (we
need to “pick” the multiline at the exact spot where we want the cut to be
made!):

|FROM| Activate the FROM object snap tool (by one of the methods
described at the start of this tutorial) ... you’ll see why we
do this in a minute!

|ENDpoint| Activate the ENDpoint object snap mode and pick the SW
inside corner of the bedroom ... AutoCAD will prompt you
for an Offset from that corner ...

Now it’s your turn again!

Don’t miss this step ...

Blips …

This section will be easier to
understand if you turn on
“blipmode” … in this mode,
AutoCAD marks each point entered
by you with a small cross known as
a blip … this can be a helpful guide.

Type blipmode ↵↵↵↵  and then type
 on ↵↵↵↵  to select that option …

To remove blips from the screen,
simply do a screen redraw …

Multiline Editing ...

Multiline Editing Tool dialogue box

  |FROM| object snap tool.
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@600,0 ↵↵↵↵ Enter a relative coordinate to define the offset ... these
three steps have accurately selected a point exactly 600
mm from the inside corner of the bedroom ... AutoCAD will
use that point to identify the multiline to be cut AND to
specify the first cut point (or the beginning of our opening)
... AutoCAD prompts for the second point (other end of the
opening) ...

@3000,0 ↵↵↵↵ Locates second end of opening 3000 mm further along the
multiline, leaving an opening of 3000 mm.

Notice that the prompt is ready for you to select another position for an opening
(with Cut All still selected).  You should be able to follow the same steps to cut
each of the other openings in both the external and the internal walls ... the size
and position of each is described in the following list (along with some hints
where appropriate).  Do not yet create the openings in the north external
wall for the bathroom and kitchen windows ... although they could be
done this way, I want to show you a different way, just for the record!

•  the entry door opening is 900 wide, and positioned 50 up from the SE inside
corner of the entry hall (use |FROM| and |ENDpoint| with an offset of either
@50<90 or @0,50 ... make sure you understand why both these offsets are
equivalent!);

•  the opening in the south wall of the Living Room is 1500 long and positioned
875 back from the SE inside corner of that room (use |FROM| and
|ENDpoint| again, but this time you are working backwards ... use an offset of
@875<180 or @-875,0 and a similar expression for the second point);

•  the window opening in the east external wall is 3000 long and positioned 500
down from the NE inside corner (work that one out for yourself!)

•  the internal door opening to the bathroom is 900 wide, and exactly fits
between the two walls (a bit tight for the builder, but who cares!) ... use
|FROM ENDpoint| and specify its position from the corner of the wardrobe
opening;

•  the last door opening is the bedroom door ... it is 900 wide and is offset 50
from the NE inside corner of the bedroom.

Press ↵↵↵↵  when you have formed the last opening to terminate the command.  I
would also use the Redraw All tool to clear away the blips.

Now re-open the Multiline Edit Tools dialogue box and use the Open Tee
intersection tool (circled in the adjacent illustration) to cleanup the four points
marked in Figure 2.  The trick here is to always pick the multiline that forms the
“leg of the Tee” first.  When you have finished the external wall junctions, your
plan should match Figure 2 below.

When you have finished this
section, it would be a good idea to
save your work (if you have not
already done so!)

  Save Drawing tool.

Cleaning up Multiline intersections

The Open Tee tool.

Figure 2
Drawing up to this point
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It’s been fairly quick and easy up to this point, but we now need to do a little
housekeeping!  The next section explains how to organise the drawing into
layers for better drawing management.  It also discusses some of the
deficiencies of multilines and paves the way to introduce some other editing
operations as we develop this drawing.

ORGANISING THE DRAWING INTO LAYERS

Your drawing will now be beginning to look (almost) like an architectural plan!
We now need to start thinking about organising the drawing into layers:  we will
have 4 separate layers for timber walls, brick walls, windows & doors, and
furniture.  Note that the default AutoCAD layer is called "0", and that is where we
are drawing at the moment.  We want to re-organise our drawing so that the
internal walls and the inner skin of the external walls are on a new "timber" layer,
and the outer skin of the external wall is on a new "brick" layer.  We will do this
by first creating a "brick" layer and moving everything onto it.  We will then
create the "timber" layer and move only the inner walls onto it.

This highlights a difficulty with the multiline entities.  Because they are single
entities, they cannot be spread between two layers (so that the inner skin is on a
separate layer to the outside skin).  In general, multiline entities are very useful
for initial, quick development of plan drawings (as we have used them here), but
can become fairly restrictive at later stages of detailing and editing of a drawing.

To avoid those detailing problems later, we can now “explode” these multiline
entities to convert them into separate simple line entities.  That gives us the best
of both worlds:  a quick tool for generating the plan layout (including openings);
and sufficient flexibility to edit the drawing later.  To issue the Explode
command, proceed as follows:

[Modify.
Explode]

Issue the Explode command ... AutoCAD prompts you to
select the objects to explode ... pick two points that define
a rectangle that fully encloses all the multiline entities ..
each entity should then be highlighted ...

↵↵↵↵ Press <Enter> to complete the selection process ... all the
multilines will become simple lines ... there will no visible
difference, except that if you pick one, only the individual
line segment will be highlighted.

The next step is to create two new layers for this drawing and assign each a
distinguishing colour.  This is done through the Layer Control dialogue box ...

[Object Props.
Layer Control]

Open the Layer Control dialogue box (illustrated in Figure
3) - this is used primarily for creating new layers and
changing the properties (linestyle and colour) of existing
layers - it can also be used to manipulate layers
(freeze/thaw, on/off, lock/unlock, etc), but that is more
conveniently done through the Layer List on the Object
Properties toolbar (to be explained later).

Notice that the dialogue box displays a list of layers (initially only one, called 0)
and a number of buttons.  Click the Show Details button to expand the dialogue.
Begin by clicking on the New button and typing the name of the layer that you
wish to create, in this case Brick.  To set the colour of the new layer, single-click
on the colour box adjacent to that layer and select the colour red from the
resulting colour dialogue box and click OK.  Finally, create another new layer

Describing the proposed layer
structure for this drawing ...

Problems with multilines ...

Explode tool.

Layer Control tool
(left end of the Object Properties
Toolbar)

The Layer Control dialogue box is
vastly improved from earlier
AutoCAD versions.  Notice the
filtering options available at the top
of the dialogue.
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called Timber and assign it the colour yellow.  Once you have done that,
dismiss the Layer Control dialogue by clicking the OK button.

Figure 3  -  The Layer Control Dialogue Box

Having created the new layers, we now have to change the lines on our drawing
to lie on those layers.  Proceed as follows ...

The first step is to select all the lines.  That is easy in this case because we can
use a selection window.  Simply pick two points (working from left to right) that
define a rectangle that fully encloses your plan.  Pick the first point below and to
the left of the SW corner of the plan, then pick the second point above and to
the right of the NE corner of the plan.  All the lines in your drawing will have
been highlighted.

Note that you just used what AutoCAD calls a “Window Selection Rectangle”
... by working from left to right when constructing the selection rectangle,
AutoCAD only selected the objects that were contained wholly inside it ... if
you were to work from right to left, the rectangle would have been displayed
dotted (known as a “Crossing Selection Window”), and all objects that either
lie inside OR cross the rectangle would have been selected.

Now pull down the list of layers on the Object Properties Toolbar and select the
Brick layer.  This will move all the selected objects to the selected layer.  Press
<Esc> twice to de-select the objects.  All the lines in your drawing should now
be on layer Brick, and therefore coloured red.

We now need to do the same thing with the internal walls to put them on the
Timber layer.  That is not as easy because they are harder to select.  You could
go through the tedious process of picking each one individually, but I will
introduce the Quick Select command that will allow you to use two Crossing

NOTE:  Filtering Layers

Clicking the button shown allows
you to filter the layers that are listed
in this dialogue or in the pull-down
list on the Object Properties
toolbar.  In the Filter dialogue, set
one or more criteria that identify the
layers you wish to retain in the list.
For example, you could list the
layer names (separated by commas
with no blanks) that you wish to
include, or you could list one or
more colours and have only layers
of that colour(s) included in the list.

Show/Hide Details Option

The dialogue illustrated has the
details shown (using the Show/Hide
Details button).  Showing the
details only makes it a little easier
(or provides an alternative way) to
change the properties of selected
layers …

Layers Pull-Down Control list ..
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Selection Windows (see note in the highlight box above) that will effectively
select all the objects in four clicks of the mouse.

Open the Quick Select dialogue (illustrated at left) by issuing the command
Tools > Quick Select from the pull-down menus.  Notice that the dialogue allows
you to select objects by filtering out ones that have particular properrties in
common.  We will not be using that feature in this case.  Simply click the Select
Objects button (circled in the figure).  The dialogue will disappear and you will
notice that AutoCAD is prompting you to select objects.

Begin by typing c ↵↵↵↵  to tell AutoCAD that you wish to use a Crossing Rectangle.
Then, pick the first two points indicated in Figure 4 (being careful to pick exactly
inside the cavity).  That will pick up most of the internal walls.  You can then type
c ↵↵↵↵  again to create a second Crossing Rectangle and pick the second pair of
points to select the remaining parts of the internal walls.  Press ↵↵↵↵  by itself to
complete the selection process.  The dialogue box will return.  Simply click OK
to dismiss the dialogue and you will be left with all the internal walls selected.
Then pull down the layer list again and select Timber to move all the selected
lines to the Timber layer.  Press <Esc> twice to de-select the objects and the
process is complete!

First two pick points

Second two pick points

Figure 4 - Pick Points for Crossing Rectangles to Select Internal Walls

If your AutoCAD happens to be configured with a white background in the
drawing area, then you may not be able to see the yellow lines very clearly ... I
suggest that you change the background colour for the graphics window (or, if
you prefer, simply change the colour of the timber layer).  To change the
background colour, select Tools > Options and then choose the Display tab.
Next, click the Colour button and, in the resulting dialogue box, set the Model
Tab Background to any colour you like ... most people seem to prefer black, but
you can try anything you like!

TECHNIQUES TO FINISH OFF THE WALLS

We are now going to use the Trim command to create the last two openings in
the external walls.  Trim is one of the small number of basic entity editing tools
that are typically available in CAD systems.  It allows you to cut away (or trim off)

Quick Select dialogue box

Setting the drawing background
colour ...

Introduction to the Trim
command ...
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parts of existing entities against cutting edges made up from other entities.  In
this case, we will create a rectangle in the spot where the opening is to appear,
then trim away the wall lines within the rectangle and then erase the rectangle.
To make the opening to the bathroom ...

[Draw.
Rectangle]

Select the Rectangle command ... we want to draw the
rectangle at an offset distance from the NW inside corner
of the bathroom, so ...

|FROM| Invoke the FROM object snap.

|ENDPoint| Invoke the ENDPoint object snap and pick the NW inside
corner of the bathroom.

@500,-50 ↵↵↵↵ Position of lower left corner of rectangle (50 below the
inside wall line so that it can be a little larger than the wall
thickness).

@1000,350 ↵↵↵↵ Opening is 1000 long ... rectangle is 100 larger than the
wall thickness of 250.

[Modify.Trim] Select the Trim tool from the Modify toolbar ... AutoCAD
prompts you to select all the objects to be used as cutting
edges ... pick the rectangle that we just created.

↵↵↵↵ Press <Enter> to indicate that you don’t want to select any
more cutting edges (you can select as many cutting edges
as you wish with this command) ... AutoCAD now prompts
you to select the objects to be trimmed ... simply pick each
of the 4 wall lines where they cross the rectangle ...

↵↵↵↵ Press <Enter>, when all four lines have been trimmed, to
terminate the selection process and end the command.

Now repeat that process yourself in order to make the second opening for the
kitchen window, which is 1500 long and positioned exactly 1800 away from the
east end of the opening we just created.  When you have finished, don’t
forget to erase the rectangles ...

The next job to do with the wall lines is to patch up the internal walls around the
bathroom door.  To do that we use another basic editing tool known as filleting.
The Fillet command is used to take any two objects (lines, arcs, etc.) that
intersect or, if one or both were to be extended, would potentially intersect, and
then extend or trim each one so that they meet, and finally insert an arc (of pre-
defined radius) into the join of the two objects.  In its most common usage, the
arc radius is set to zero so that the two objects join at a single point.  The
illustration in the margin supports the following instructions to use the Fillet
command to clean up the internal wall gaps ... you should zoom in on this part of
your drawing before proceeding (use the Zoom Window tool again).

[Modify.Fillet] Invoke the Fillet command ...

r ↵↵↵↵ Select the Radius option … AutoCAD seems to assume a
radius of 10 as the default … we need to change that to 0
so that the lines join at a sharp point.

0 ↵↵↵↵ Radius of 0 … AutoCAD now prompts you to pick two
objects ... pick the two objects at the points labelled ! & "
in the illustration ... AutoCAD should join the lines at a
point.

↵↵↵↵ Press <Enter> to recall the Fillet command ... repeat the
process, this time picking the objects at the positions
labelled # & $ in the illustration ...

Rectangle tool.

The toolbar object snap modes
did not work for me here ... use
Shift-Right Mouse Button and
pick them from the pop-up
cursor menu instead ...

Trim command tool.

Now try it yourself on the last
opening ...

Introduction to the Fillet
command ...

Fillet command tool.

!!!!

""""

####

$$$$

Pick points for the fillet operation.



11 Updated:  April 2000 AUTOCAD 2000 - Drawing the Granny Flat Plan

Having zoomed in to do this editing, now use the Zoom Previous command to
return to the last view that you had of your drawing

The last step in cleaning up the walls involves closing off the ends of the two
external wall skins around the main entry door ... this is so that we can later
insert a door jamb across the cavity.  We don’t have to worry about the other
openings because they will be hidden by the window & door jambs in each case!

[Standard.
Zoom
Window]

Use Zoom Window to enlarge the area around the main
entry door (as illustrated in Figure 5).

[Object Props.
Layer Control]

Pull down the layer list (click the down arrow!) in the Layer
Control tool (as illustrated) and pick the Timber layer ... this
makes that layer “current”, meaning that every new entity
that we draw will be placed on that layer.

[Draw.Line] Invoke the Line command ... use |ENDpoint| to pick on the
two points labelled ! in Figure 5.

↵↵↵↵   ↵↵↵↵ Press <Enter> twice to terminate and then re-invoke the
Line command ... remember, you can always recall the last
command ... pick the points labelled "to close the timber
skin on the south side of the opening.

↵↵↵↵ Terminate the Line command.

You should now make the Brick layer current, and then repeat the process to
clean up the outer skin (points labelled # and $ respectively).  Finally, use
Zoom Previous to view the whole drawing again.

CREATING THE WINDOW AND DOOR BLOCKS

Before drawing the windows and doors, you need to create a new layer (which
you should call "windoors") and then make that the current layer (by selecting it
and clicking the Current button before closing the dialogue box).  Do that
yourself using the Layer Control dialogue, and making it any colour that you
wish!

For the purposes of this exercise, we are going to draw the window and door
symbols in a blank area of the drawing and then store them as blocks.  Once
created, instances of these blocks can be inserted anywhere on the drawing, at
any rotation and scale.  We will do the doors first (because they are all the
same, and therefore slightly easier).

Create and Insert the Door Blocks
Figure 6 shows what the finished door symbol will look like.  We will begin by
drawing a rectangular door frame (arbitrarily 100 x 40 mm), copy that to form the
second frame and then draw the door swing as a polyline.  Proceed as follows:

[Draw.
Rectangle]

Issue the Rectangle command - pick a starting position in
the living / dining area, roughly above the entry doorway.

@40,100 ↵↵↵↵ Top right corner of the rectangle - at this point, you may
wish to zoom in on the door drawing to make your task
easier.

..Zoom Previous tool.

Cleaning up around the main entry
door ...

Layer Control tool.

!

"

#

$

Figure 5  -
Cleaning up the Main
Entry Door

Create a new layer ...

Figure 6  -
The Finished Door Block.
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[Modify.Copy] Issue the Copy command in order to duplicate the frame at
the other end of the door - in response to "Select objects:"
prompt, pick the rectangular frame just created.

↵ To complete the selection process - then pick a "Base
point" anywhere on the drawing to define the first end of
the copy vector.

@860<0 ↵↵↵↵ To define the "End point" of the copy vector - door will be
900 mm wide with an opening width of 820 mm.

This polyline is to begin at a position offset from the lower-right corner of the left
door frame by 20 mm in the X direction and 50 mm in the Y direction.  First
zoom in on the area around and above the two door frames and then proceed
as follows:

[Draw.Polyline] Issue the Polyline command - use |FROM| and |ENDpoint|
(as described several times now!) and snap to the lower-
right corner of the left door frame.

@20,50 ↵↵↵↵ Defines the "Start point" of the polyline as an offset
distance away from the “Base Point” located at the lower
right corner of the left door frame.

@780<90 ↵↵↵↵ Length of the door swing - 40 mm less than the door
opening size!

a ↵↵↵↵ Selects the Arc option to initiate an arc segment in the
polyline.

d ↵↵↵↵ Selects the Direction option to force AutoCAD to begin the
arc in a specified direction.

@100,0 ↵↵↵↵ To specify the desired direction as "easterly".

@780,-780 ↵↵↵↵ To nominate the end point position of the arc.

↵↵↵↵ To complete the polyline command.

The next step is to convert this drawing into a "block" so that instances of it can
be placed at different locations in the drawing.

♦  Issue the Make Block command from the Draw toolbar (illustrated);

♦  Enter the Block Name “door” in the space provided;

♦  Click the Pick Point button and use |ENDpoint| to locate the base point at
the lower left corner of the door symbol;

♦  Click the Select Objects button and construct a selection box (window)
around the entire door symbol to identify the entities to be included in the
block;

♦  Make sure that the Delete option is checked since we don’t wish to keep the
entities used to create the block.

The procedure to insert the door symbol is controlled by a dialogue box.  This
may be opened by either typing insert ↵↵↵↵  or clicking the Insert Block tool on the
Draw toolbar.  The dialogue box is illustrated over the page.

Select the Door block by pulling down the list in the name box.  We wish to
position the block on the screen, so leave that option checked.  We don’t wish to
change the scale of this block, so leave that option unchecked.  However, we
may wish to rotate the block as we insert it, so that option should also be
checked as shown in the figure.  Click OK when ready.

Draw Polyline tool.

NOTE:  you could use a
combination of Polar Tracking and
Object Tracking to make this
drawing process a lot easier than
described … feel free to try that for
yourself!!

Make Block tool.

Block Definition dialogue …

Insert Block tool.
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[Standard.
Zoom
Window]

Issue a Zoom Window command (this is a transparent
command, meaning that it can be executed while another
command is active) ... zoom in on the entry door area of
the plan - AutoCAD will perform the zoom and then
automatically resume the insert operation.

|NEArest| Invoke the NEArest object snap mode (this snaps to the
nearest point on the entity selected) ... pick a point just east
of the cavity at the south end of the door opening for the
main entry door ... AutoCAD should snap to the line that
closes the end of the brick skin - this sets the position of
the insertion point.

90 ↵↵↵↵ Specify a rotation value of 90 … you could use Polar
Tracking to specify this rotation rather than type it!

The first door should now be in position, neatly closing the 40 mm cavity.  Use
Zoom Previous to display the whole drawing.  Use the same procedure to enter
the other two doors, this time using |ENDpoint| snap to accurately position them
and Polar Tracking to get the rotation correct.

That completes the doors.  We now have to make the windows, cross-hatch the
walls and insert the furniture.  We will then be ready to set up the final layout of
the plotted sheet.

Don’t forget to save your drawing before going on!

CREATE AND INSERT THE WINDOW BLOCKS

The process this time is generally the same as for doors, except that there are
three window sizes in this plan.  We will therefore create three different blocks,
one for each window size.  The first window block will be created from scratch
and then inserted.  The second one will be created by modifying the first block,
and then inserting that in two of the openings.  The third window block will be
created and inserted by you, on your own, so make sure that you understand the
process the first two times!  Before proceeding, check that the current layer is
set to WINDOORS, then create the first window block (as illustrated in the
margin) as follows:

Zoom Window tool

The Nearest Object Snap tool.

NOTE:  using this specific object
snap mode effectively overrides
Running Object Snap which should
still be in effect at this point …

Save Drawing tool ...

Brief outline of the plan for this
stage ...

The Completed Window Block
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[Draw.
Rectangle]

Issue the Rectangle command to draw the end frame
member - select a starting point anywhere towards the
lower left corner of the living area ...

@50, 250 ↵↵↵↵ Opposite corner of the rectangle.

Now, adapt the steps described when creating the door symbol, to copy this
frame 950 mm to the right (this will create an overall window width of 1000 mm).
You will probably want to zoom in on your window before proceeding ...

[Draw.Line] Issue the Line command to draw one side of the window
(between the frames).

|ENDPoint| Select the ENDPoint snap mode and then pick the top right
corner of the left-hand rectangular frame.

|ENDPoint| Specify the end of the line using ENDPoint snapping on the
top-left corner of the second frame.

↵↵↵↵ Complete the Line command.

[Modify.Offset] Issue the Offset command to draw the remaining lines
along the length of the window.

120 ↵↵↵↵ Distance of offset - pick the line just created and then pick
a second point below it.

↵↵↵↵  ↵↵↵↵ Complete the command and then recall the command a
second time (to draw a second offset with a different
distance).

10 ↵↵↵↵ Distance of offset - pick the line just created (by the last
offset) and then pick a second point below it.

Without further instruction, offset the line just created through a distance of 120
mm to complete the window .

We will now add an 80 mm brick-on-edge sill to our window using the Line and
Array commands.  You should draw the outline Object Tracking …

[Draw.Line] Issue the Line command (not Polyline!!) … beginning with
an |ENDPoint| snap on the SW corner of the window …

@0,-80 ↵↵↵↵ To draw the first segment 80 mm down the sheet ... Then
use Object Tracking to pick the next point, lining up
orthogonally with the other end of the window (with POLAR,
OSNAP & OTRACK all selected, move the mouse over the
SE corner of the window and then back to the
approximately correct position so that you have two
intersecting tracking lines, then click that point) …

|ENDpoint| Snap to the SE corner of the rightmost window frame to
complete the outline of the sill.

↵↵↵↵ To complete the Line command.

To draw the brick joint lines along the sill we use another useful drawing tool.
This is called the Array command and works as follows over the page:

Rectangle tool.

Have a go yourself ...

Draw Line tool.

ENDPoint Object Snap mode.

Offset tool.

Now it’s your turn again ...

Using Object Tracking to draw
the outline of the window sill  ...
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[Modify.
Array]

Issue the Array command - this command is used to
produce multiple copies of entities arranged in a
rectangular grid (numbers of rows and columns) or a
circular pattern - we will use the rectangular grid option
have one row and several columns - in response to the
prompt, pick the left-most edge of the brick sill just drawn.

↵↵↵↵ Complete the selection process.

↵↵↵↵ Accept the default Rectangular option.

↵↵↵↵ Accept the default number of rows (1).

10 ↵↵↵↵ Specify 10 columns.

100 ↵↵↵↵ Space between columns (not precisely correct for bricks-
on-edge, but will do for our drawing!)

Follow the same process as with the doors to create the window block and then
use Zoom Previous to restore the earlier view and insert an instance of this
block into the window opening in the bathroom (hint:  make the insertion point
the SE corner of the window opening and rotate it through 180o).

To create the second window block, we will insert the first block in a blank area
of the drawing, stretch it to the new length we require, and then save it under a
different block name:

insert ↵↵↵↵ Issue the Insert command (by typing it, or using a toolbar if
desired) - without further instruction, place the instance in
the living area of the plan, unscaled and unrotated ... then
proceed as follows ...

[Standard.
Zoom
Window]

Issue the Zoom Window command and zoom in on the
window (being careful to leave room to extend the window
to the right).

[Modify.
Explode]

Issue the Explode command and, as instructed by
AutoCAD in the Command Window, pick the window just
inserted - this will cause AutoCAD to convert this instance
of a block back into normal graphics so that it can be
modified.

[Modify.Stretch] Issue the Stretch command - create a selection box
beginning at the lower-right corner as illustrated in the
margin (being careful not to include any of the sill brick
lines in your selection).

↵↵↵↵ To complete the selection process - AutoCAD now
prompts you to specify two points to define the distance
and direction in which to "stretch" the portion of the entity
that we have selected - pick a point anywhere to serve as
the base point of the stretch vector and then proceed as
follows ...

@500,0 ↵↵↵↵ Define the second point of the stretch vector - the window
should stretch to 1500 mm long.

Now use the Array command, as before, to duplicate the right-most brick sill line
to fill the gap just created.  This time, specify 6 columns with 100 mm spacing.

Array tool.

Forming the Window block …

  Zoom Previous tool.

Creating the second window
block ...

Zoom Window tool.

Explode tool.

Stretch tool.

!

"

The Selection Box that should be
used for the Stretch command in
this example

Use the Array command yourself ...



16 Updated:  April 2000 AUTOCAD 2000 - Drawing the Granny Flat Plan

When the window drawing is complete, create another new block out of it, this
time called "w1500", making the insertion point again in the NW corner.  Zoom
out again and insert two instances of this new block, one in the kitchen window
opening and the other in the window adjacent to the entry porch.

When that is complete, repeat this whole process again to create a third window
block called "w3000", this time 3000 mm long.  That is, insert the "w1500" block
in a temporary location, explode it, stretch it by 1500 mm, use the Array
command to duplicate the last sill line across 16 columns with 100 mm spacing,
create the new block, and then insert instances of it into the dining / living room
(east wall) and into the bedroom window openings.

We have now finished the base plan.  The next step is to hatch the brickwork,
then draw in the furniture and finally, set up the drawing sheet layout.

HATCHING

Now that the windows are in position, it is possible to cross-hatch the outer skin
of brickwork.  To do that, we first need to make Brick the current layer, giving us
an excuse to introduce another shortcut:  the Make Object’s Layer Current
button (as illustrated).  First click this button once and then pick any line on the
Brick layer (red) … AutoCAD will then set the current layer to be the same layer
occupied by that entity (ie. the brick layer).

Next, call up the Boundary Hatch command ...

[Draw.Hatch] Select the Boundary Hatch command - this will bring up the
Boundary Hatch dialogue box (Figure 2 below).

Using that dialogue, work through the following steps:

•  ensure that the Type is set to "Predefined" ... this means that you are using
one of AutoCAD’s built-in patterns ... the other options are User-defined (to
create a pattern “on-the-fly”) or Custom (to use a pattern that you have pre-
defined yourself);

•  Click on the pattern selection button (marked in the figure) and choose the
"ansi32" pattern from the choices offered in the Hatch Pattern Palette box ...
that pattern will then be displayed at the top of the Boundary Hatch dialogue
box as illustrated;

Figure 2  -  The Boundary Hatch Dialogue Box

You can now finish off the windows
all by yourself ...

Make Object’s Layer Current tool

(located on the extreme left end of
the Objects Property toolbar above
the drawing area)

Boundary Hatch tool …
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•  set the Scale value at 20, but leave the Angle setting at 0;

•  next, click the Pick Points button ... the dialogue box will temporarily
disappear allowing you to pick points on the drawing within each of the areas
to be cross-hatched ... while observing the prompt in the Command Window,
pick the points marked in Figure 3 below noting that as you pick each one,
AutoCAD marks the corresponding boundary ... you can cancel any one pick
by typing u ↵↵↵↵  if you make a mistake ...when all boundaries have been
identified, press ↵↵↵↵  to return to the dialogue box;

•  if you wish to check the hatching before committing yourself, click the
Preview button ... you can interrupt the previewing process by pressing
<Esc> if you find the hatching is incorrect or too dense;

•  when satisfied, click the Apply button to dismiss the Boundary Hatch
dialogue box and draw the cross-hatching.

This would be a good time to save your drawing by clicking the Save tool on
the Standard toolbar:

DRAWING THE FURNITURE ITEMS

Before we begin drawing the furniture, you must create a new layer called
"furniture" (any colour that you wish!), making that the current layer.  Since we
don’t want the furniture to be too prominent, set the Lineweight to 0.18 for that
layer.  This process has been described twice now:  try to do it yourself from
memory.

Once that is done, we will begin by drawing the built-in wardrobe in the bedroom
and then the kitchen benches.  After that, we will use blocks to draw the rest of
the furniture items shown on the plan.

To draw the line which delineates the built-in wardrobe, issue the LINE
command and begin at the SE corner of the wardrobe with an |ENDPoint| snap
mode and then use a |PERpend| snap mode for the second point, picking the
inside face of the west external wall.

NOTE:  from my experience, there
seems to belittle consistency in
AutoCAD about pattern scales
when using their predefined
patterns … the best strategy is
always to create a small test
rectangle and experiment in that
small area with the predefined
pattern you plan to use … I did
exactly that to establish that a scale
factor of 20 was “about right” for
this drawing …

Figure 3  -  Pick Points to
Set Up the Boundaries for
Hatching

Save tool.

Overview of where we’re
heading!

Built-in Wardrobe ...
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We will draw the kitchen benches as a polyline beginning 1400 mm up from the
SW corner of the kitchen (adjacent to the bedroom door).  We have already
outlined how to use the |FROM| object snap mode to specify the start point of
such a line.  Endeavour to construct the polyline yourself, referring back to the
earlier example where necessary:  begin at the point indicated, draw 700 to the
right, 900 up, 1500 right, 1400 down, 600 right, and then finish the polyline
perpendicular (|PERpend| object snap mode) to the inside face of the north wall
of the kitchen.  Check that your benches are the same as the sample plan.

The next step is to add the other furniture symbols to the drawing.  Normally,
over a period of time, you would build up a "library" of commonly-used
furniture symbols to use in this kind of drawing.  This is done by drawing
each symbol, making a block out of it, and then writing that block onto a
separate drawing file all by itself.  You are then able to insert that block, from
its separate drawing file, into any drawing that you produce in the future.
Note that AutoCAD provides no such standard library, although there are
several third-party vendors who will.  (In the next tutorial, you will use one
such standard library, but in this tutorial we are deliberately only using the
basic facilities provided by AutoCAD.)

For this tutorial, we will use another technique to draw all the furniture items.
Notice that all the remaining furniture in this plan can be made up from one or
more simple rectangular boxes.  We will create a new block, called "box", which
will be a simple rectangle 1000 mm square.  We will then insert that block into
the drawing, using different X and Y scale factors each time, to build the
symbols to represent the furniture that we wish to show.  This is probably not the
normal way of doing it, but it serves to illustrate an important way in which you
can use blocks.

Begin by drawing a Rectangle 1000 mm square anywhere on your drawing.  Use
the Block command to save this square symbol as a block called "box", with the
insertion point at its SW corner.

Zoom in on the bathroom / kitchen area of your plan as shown in Figure 4 and,
using that figure as a guide, insert the furniture as instructed.

Figure 4  -
Plan of the Bathroom /
Kitchen Area showing
the Furniture

We will begin with the Fridge in the SW corner of the kitchen ...

Kitchen benches ...

... use the |FROM| object snap
mode

Polyline tool.

A unique approach to drawing
furniture ... you could argue that it
would be easier to draw simple
rectangles for each item, but it
would not be half so instructive!!

Create the basic furniture block ...
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insert ↵↵↵↵ Issue the Insert Block command .. use the Insert Block tool
in the Draw toolbar if you prefer … in the dialogue box, set
the position and scale to be set on the screen with rotation
set to 0.

box ↵↵↵↵ An outline of the box symbol should appear attached to the
cross-hair cursor - AutoCAD will prompt you for an
insertion point - pick a point close to, but not on, the SW
corner of the kitchen (refer to figure!) … Hint:  you will
need to temporarily disable Running Object Snap  by
clicking the OSNAP button on the Status Line (illustrated at
left) to do this operation without snapping to the corner of
the Kitchen.

0.6 ↵↵↵↵ Set the X-scale factor to 0.6 times the current size of the
object - this will result in a box 600 mm wide.

↵↵↵↵ Set the Y-scale factor to the same as the X factor.

Use the Line command with |ENDpoint| object snapping to draw a cross through
this rectangle (as illustrated) to distinguish it from other fixed items of furniture.
Then use the same insertion technique to draw the Wall Oven next to the
Fridge.

I will lead you through the process of drawing the Double-Bowl Kitchen Sink and
the bath tub, and then leave you to draw the other furniture items yourself.

insert ↵↵↵↵ Re-issue the Insert command.

↵↵↵↵ Accept the default block to insert ... it should be the "box"
since that was the last thing inserted - pick an insertion
point, judged by eye, where you want to draw the kitchen
sink.

1.2 ↵↵↵↵ Set the X-scale factor to 1.2 times the current size of the
object - this will result in a box 1200 mm long.

0.4 ↵↵↵↵ Set the Y-scale factor - 400 mm wide.

↵↵↵↵ Recall the Insert command

↵↵↵↵ Accept the default block to insert.

@330,50 ↵↵↵↵ Specify the insertion point relative to the last point entered:
that is, the insertion point of the last box!

0.25 ↵↵↵↵ 250 mm long.

↵↵↵↵ Same width.

[Draw.
Copy Object]

Issue the Copy command from the Draw toolbar - select
the sink tub just created.

↵↵↵↵ Complete the selection - pick a Base Point anywhere you
wish.

@290<0 ↵↵↵↵ Place the copy 290 mm to the right … you may need to
pick the whole sink unit and use the Move command to
adjust its position a little.

insert ↵↵↵↵ Re-issue the Insert command.

↵↵↵↵ Accept the default block to insert ... it should still be the
"box" since that was the last thing inserted.

Drawing the Fridge ...

  Insert Block tool

OSNAP Status Line button …

... complete the Fridge ...

... then draw the Wall Oven ...

Double-Bowl Kitchen Sink ...

Bath Tub ...
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|ENDPoint| Select the ENDPoint snap mode and then pick the NW
corner of the bathroom to lock the position of the Bath right
into the corner.

1.5 ↵↵↵↵ Box 1500 mm wide.

-0.75 ↵↵↵↵ Set the Y-scale factor to a negative number in order to
draw the box in a negative direction relative to the insertion
point.

↵↵↵↵ Recall the Insert command.

↵↵↵↵ Accept the default block to insert.

@100,-100 ↵↵↵↵ Specify the insertion point relative to the last point entered,
that is, the insertion point of the last box.

1.3 ↵↵↵↵ Set the X-scale factor to 1300 mm wide.

-0.55 ↵↵↵↵ 550 mm wide in negative Y direction.

You can now proceed on your own to insert the following furniture items:

•  Vanity Unit in NE corner of bathroom - 900 x 450 mm with centred bowl 400
x 300 mm.

•  Washing Machine in SW corner of bathroom - 700 x 600 mm, crossed, since
it is not built-in.

•  WC next to the bath - cistern 200 x 500 and pan 400 x 300 mm.

Have a go at drawing the floor waste in the bathroom by yourself:  use a 30 mm
radius circle, with two 100 mm cross lines.  When you are satisfied with it, copy
it into the Bath as well to serve as the plug hole.

Finally, draw the threshold at the main entry door, and then draw in the edge of
the entry porch using the Object Tracking tool as we did when we constructed
the window sill earlier in this tutorial.

The final change that I made to this drawing was to incresae the line weight on
the external faces of all the walls.  I set mine to 0.70 the first time, but would
suggest that you could use 0.50 instead.  Use Quick Select (as you did earlier)
to select all the lines, then pull down the list of line weights and choose the one
you think is most appropriate.  If you wish to preview the lineweights on the
screen, click the LWT toggle on the Status Line.  If the line weights are shown
too exaggerated (likely on the high resolution monitors in the labs!), then select
Format > Lineweight and adjust the slider back to the first notch and click OK.

That now completes the plan of our granny flat!!!  Your drawing should now look
like the one in Figure 1.  The final step is to layout a drawing sheet with a couple
of views of the plan and a bit of text (as in the completed drawing at the end).

LAYING OUT THE DRAWING SHEET

AutoCAD supports two modes of operation:  up to this point, everything we have
drawn has been in Model Space where objects are drawn at their real-world
size;  we are now going to switch to Paper Space so that we can lay out an A4
sheet of paper (drawn at its actual size) and place two scaled drawings of our
granny flat on it.  This final layout is shown at the end of these notes.  Proceed
as follows:

Look below the drawing area and note the row of tabs, the first labelled Model
and the others labelled Layout1, Layout2, etc.  The layout tabs allow you to set

Do the rest yourself, using the
same techniques ...

Bits and Pieces ...

Adding Lineweights …

Brief Introduction to Paper
Space ...
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up layout drawings in paper space.  Click on the first of these.  AutoCAD will
open the Page Setup dialogue box.  Notice that the dialogue has two tabs.
Select the Plot Device tab.  On that tab, pull down the list of plotter names and
select the one labelled “BlackWhite” (this “device” suits any of the A3/A4 printers
available in the Faculty).  Below that, pull down the list of Plot Style Tables and
select “monochrome.ctb”.  This plot style will ensure that your plot is printed in
solid black (the laser printers tend to print coloured lines in shades of grey which
creates an unsatisfactory effect for CAD drawings!).  Next, switch to the Layout
Settings tab and ensure that A4 paper is selected and the orientation is set to
Landscape.  Click OK.

AutoCAD will then display your sheet as shown in Figure 5 below.  The sheet is
displayed on a grey background with a dotted line representing the plotter
margins (outside of which the device cannot print).  Within that margin is created
a single rectangular viewport containing a view of your drawing from Model
Space.

Figure 5  -  The A4 Sheet Showing the Initial Viewport

To set up the drawing sheet, work through the following steps:

•  the first thing to do is to set the current layer back to "0";

•  draw a rectangle 277 wide by 190 high (20mm smaller than an A4 sheet) –
use the Move command to position that rectangle within the plotter margins
(dashed rectangle) and centred on the page - this rectangle will serve as the
sheet border.

The next step is to set the scale of the plan within the viewport and then adjust
the size of the viewport to suit … I always suggest that it is best to make the
viewport only a little bigger than the view it encloses.  Proceed as follows:

Click the PAPER toggle on the Status Line -  this allows you
to work in model space within one of the displayed
viewports - since you only have one viewport, there is no
ambiguity about the one with which you wish to work:
where there is more than one viewport, you can switch
between them merely by clicking on the one you want.

... note that the toggle button on the
Status Line changes to

 to indicate that you are
now in Model Space and the
crosshair cursor appears within the
viewport.
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[Standard.
Zoom Scale]

Select Zoom Scale command - this allows you to set a
scale factor to be applied to the view …

1/100xp ↵↵↵↵ This is the scale factor to be applied to the zoomed view - it
means a factor of “one-hundredth” of the paper space
scale (the significance of "xp") - since paper space is at a
scale of 1:1, this sets the viewport to a scale of 1:100.

[Standard.
Realtime Pan]

Use the Realtime Pan tool to position the plan in the
bottom left corner of the viewport … simply click the tool
button (as illustrated), move to any position in the viewport
and hold down the left mouse button while dragging the
view around until you are happy with the position (as close
to the lower left corner as you can make it!) … press
<Esc> to turn off Realtime Pan.

Click the MODEL toggle button on the Status Line - this
switches back to paper space - notice that the cross hair
cursor now spans the whole drawing area again.

Once back in Paper Space, you are able to re-size the viewport so that the plan
at 1:100 scale fits snugly within it.  The simplest way to do that is to use grip
editing as illustrated.  Simply click on the viewport and observe that it is
highlighted with blue boxes (editing grips) at each corner (difficult to see on the
white background!).  Click on the top-right corner grip until it is highlighted, then
move the cursor (without holding down the mouse button) until the viewport
neatly encloses the plan (as shown at left), and finally click on that position.  The
viewport should now be just bigger than the plan view. Now use the Move
command to re-position the viewport to anywhere you wish within the A4 border.

We now need to create a second viewport.  Just for fun, we will make this non-
rectangular.  Proceed as follows:

circle ↵↵↵↵ Construct a circle to use as a viewport … you can actually
use any closed polygonal shape that you can create with
AutoCAD, but we will simply use a circle ….

mview ↵↵↵↵ Issue the Mview command - this command allows you to
create a new viewport in paper space …

o ↵↵↵↵ Select the Object option … AutoCAD will prompt you to
select any closed shape … pick the circle that you just
created.

Now use exactly the same procedure to create a 1:50 scale plan drawing of the
bathroom within that viewport ... the end result is illustrated in final drawing at
the end of this tutorial.  Note that when you use the Zoom Scale command to set
the viewport scale, you need to specify the scale factor as “1/50xp”.  Once you
have re-sized the new viewport, you should use Move to adjust the position of
both viewports until you are satisfied with the layout.

When you have done that, we need to make the viewport borders invisible since
they are not an essential part of our drawing.  That is done by creating a new
layer (perhaps called "vp"), changing the two viewports to that layer, and then
making it a “non-plotting” layer (that being one of the properties of layers).  You
should be able to do all that by yourself!

The last thing to be done now is to label the drawing.  There are two steps to
that process:  first you need to create a new text style to use;  then you use the
Text command to create items of text in that style.  This is all best done in paper

Zoom Scale tool (in the Zoom flyout
on the Standard Toolbar) …

Realtime Pan & Zoom tools …
these are great for quick zoom &
pan operations …

Re-Sizing the Viewport Using Grip
Editing techniques ...

Create the second viewport ...

  Circle tool

You could also call this command
from the pull-down menus ...

View > Viewports > 1 Viewport

Making the viewport borders
invisible ...

Labelling the Plan ...
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space using text at its plotted size (since paper space is always plotted at 1:1
scale).

Begin by issuing the Format > Text Style command from the pull-down menus.
You will get the following dialogue box …

Click the New button to create a style giving it any name you wish (I called mine
“Granny1”).  Pull down the list of fonts and choose any that takes your fancy.
The fonts are previewed in the lower right corner of the dialogue.  It is prudent to
leave the height of the font as 0.0 (as in the illustration) since that tells AutoCAD
that for this style, you will specify the height on the fly for each piece of text.
When ready, click OK to continue … the text style you just created becomes the
current style and will be used for any text you create until you create/select
another style.

To create an item of text proceed as follows …

Draw >Text >
Single Line
Text

Issue the Single Line Text command - we are going to
enter the main title of the drawing:  "Proposed Granny Flat"
- pick the appropriate spot on the drawing.

7 ↵↵↵↵ Set height of text at 7 mm.

↵↵↵↵ Accept the default rotation of 0o.

Then type in the text “Proposed Granny Flat” followed by ↵↵↵↵ .  Then press ↵↵↵↵
again to terminate the command.

Following the same process, now enter any other text you wish to add to your
drawing.  All the text is inserted in paper space, even that which appears on top
of the model views in the viewports.  The drawing titles and the "Drawn by" line
were all entered in 5 mm text.  The rest is 2 mm high text.

All done.

Creating a new text style ..

Previewing the Available Fonts

A useful hint:  if you select any font
name in the pull-down list, you can
then use the DownArrow key to
scroll down through the list of fonts
watching the Preview box to find a
font that suits your needs … that’s
a convenient way of finding a font!

Hint:  use Single Line Text for
labels as we do here, but use
Multiline Text for blocks of text …

… the text button on the Draw
toolbar executes the Multiline
Text command which is why we
don’t use it here …
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